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Chapter 1

Scope

This document is intended as a Quickstart guide to Phase 1 proposal preparation in Cycle 3 for the novice
ALMA Observing Tool (OT) user. It takes the reader through all the basic steps to create an ALMA Observing
Proposal, and contains some useful tips for the novice user in particular.

A more comprehensive description of the OT and the different aspects of proposal preparation can be found
in the ALMA OT User Manual. The ALMA OT Reference Manual provides a more concise explanation for
all the fields and menu items in the OT, and can be accessed interactively from within the OT by clicking on
the ? icons. All the documentation (including this Quickstart Guide) can also be accessed and
interactively searched via the Help menu in the OT. For a visual demonstration of different aspects of
the OT you are invited to consult the suite of ALMA OT video tutorials.
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Chapter 2

Getting started

In order to access the ALMA Archive and submit an observing proposal, you must have previously registered
with the ALMA Science Portal. You can then download the OT from the OT page in the ALMA Science
Portal. Please follow the detailed installation instructions there; in case of any problems you can consult the
Troubleshooting page. You start the OT either by clicking on the ALMA OT icon (Web Start) or from the
command line by typing ./ALMA-OT.sh in the installation directory (tarball). A splash screen with different
options will appear. To follow the step-by-step guide for creating a new Cycle 3 proposal submission, please
select the first option ’Create a new proposal’ 1.

If you would like to re-submit a proposal from Cycle 0, 1, or 2 as a new Cycle 3 proposal you
can simply open the old version saved on disk in the OT, edit it as needed, and submit it.
This project will then be assigned a new (Cycle 3) project code. You will however not be able
to edit proposals from previous cycles retrieved from the ALMA Science Archive. If you did not
save a local copy of the .aot file you would like to re-submit, you can retrieve the old proposal
from the archive and open it as a template. This will allow you to at least copy individual
Science Goals into a new Cycle 3 project; the proposal information must however be filled from
scratch.

Alternatively, once the OT has opened you can select the green New Proposal (Phase 1) button from the toolbar
in the OT. You will be presented with the window shown in Fig. 2.1, which illustrates the main Graphical User
Interface (GUI) components:

Menu: Allows access to all functions available in the OT via pop-up submenus.

Toolbar: A selection of icons for some of the most frequently used functions in the Menu.

Project Structure Pane: Visualisation and navigation of the Project tree. You can expand and
collapse parts of the tree by clicking the node icon to the left of each component

Editor Pane: The technical specifications of the project are filled and edited in this pane. The content of
the editor pane changes depending on the branch of the Project tree selected. For the spatial and spectral
setup the editor panes are composed of several tabs.

Feedback Pane: Provides feedback on the validation process and allows you to identify problems with
your proposal.

Overview Pane: Informative summary of the proposal creation process and contextual help.

1Choosing ’Create a new DDT proposal’ will present you with the Cycle 2 version of the OT until the end of Cycle 2. This option
must not be used to submit Cycle 3 proposals.
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Figure 2.1: OT Graphical User Interface.

You can customize the GUI according to your needs. The size of the different panes can be
modified by clicking and dragging their borders, or maximised/minimised by clicking on the
triangular arrow symbols. You can toggle the Overview and Feedback panes by clicking on View
>Feedback/Overview in the Menu, e.g. in order to maximise the Editor pane. The Feedback
pane will normally not be visible upon starting the OT, but it will pop up when the project is
validated (see Step 3.10). You can customise the OT further by selecting File > Preferences.
In particular, you may want to change the font size or colour scheme, or preferentially show
certain editors.
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Chapter 3

Proposal creation and submission in 10
easy steps

1. Enter the basic information for your proposal

2. Attach supporting material

3. Create a Science Goal

4. Add the source information

5. Configure the spectral setup

6. Finalise the spatial setup

7. Select the calibration strategy

8. Enter the control and performance parameters

9. Enter the technical justification

10. Validate and submit your proposal

3.1 Enter the basic information for your proposal

Start by filling the fields in the Proposal editor pane labelled Proposal Title and Abstract, select the
Proposal Type and Scientific Category using the radio buttons and choose up to two Keywords from a list (to
select multiple keywords hold the Ctrl button, or the Cmd button on Macs). To facilitate filling in the abstract
you can launch an editor, which allows you to load and edit a previously prepared text file. You can optionally
provide additional information on previous proposals or recent publications related to the project.

You can copy and paste text in the usual way using Ctrl-c and Ctrl-v. On Macs, the usual
Cmd-c and Cmd-v does not work, you need to use the Ctrl button instead.

In order for you to be able to submit the proposal, you will have to select yourself as PI by scrolling down,
pressing the Select PI button and searching by name, e-mail or ALMA ID in the pop-up window (see Fig. 3.1).
The ALMA ID is your Science Portal login.

You can select an unlimited number of Co-Is in a similar way, provided that they have previously
registered with the ALMA Science Portal. Please make sure they do so at least 24 hours prior to the
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Figure 3.1: Select the PI and Co-Is in the Proposal editor pane.

submission deadline. If you have a long list of Co-Is you may prefer to add them from a proposal previously
saved on disk using the Add from proposal button.

3.2 Attach supporting material

In the second step you attach supporting material used for the scientific assessment of your proposal. You
are required to present your science case in a single .pdf file not exceeding 4 pages in total, including any figures
and tables. The science case should put the proposed observations in a broad scientific context, highlight their
impact on the field of research and present the immediate goal you expect to achieve. While the text of the
technical justification is entered directly into the OT (see Step 3.9), any associated figures must still be included
in this .pdf file. For more details please see the General Guidelines for writing a proposal section of the Proposers
Guide.

3.3 Create a Science Goal

All the technical specifications for your project are contained in one or more Science Goals. Each Science Goal
may contain up to a total of 150 pointings attributed to one or more sources of the same target type (offset
pointings or rectangular mosaic) located within 10◦ of each other on sky, and is limited to one correlator setup
with up to five frequency tunings, one calibration strategy, and one set of Control and Performance parameters
(see Step 3.8). You create a new Science Goal by clicking on the New Phase 1 Science Goal icon in the
toolbar or selecting Edit > New Phase 1 Science Goal from the Menu. The Science Goal can be renamed by
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Figure 3.2: Adding the source information in the Field Setup pane.

right-clicking on the Science Goal node and selecting Rename, or by visiting the General editor pane, where a
short description of the Science Goal may also be optionally entered in the corresponding field. A template
library containing a range of pre-defined science goals can be brought up with View > Show ALMA Template
Library.

You can easily copy and paste Science Goals, or parts of a Science Goal such as the spectral
setup. In the Project tree, right-click on the component you want to copy and select ’Copy’ (the
Science Goal copied will turn pink). Then right-click on the next higher branch of the Project
tree where you want to paste and select ’Paste’. Alternatively, you can select a node and drag
& drop it to where you want it copied. Note that Science Goals can only be pasted/dropped
at the Proposal or Planned Observing node level, and parts of a Science Goal can only be
pasted/dropped at the Science Goal node level. You cannot e.g. paste a Science Goal into
another Science Goal.

3.4 Add the source information

A source can contain either one or more individual pointings (offset pointings or custom mosaic) or 1 rectangular
mosaic. All pointings defined in a given source share the velocity information and Expected Source Properties.
Setting up the actual pointings within a source is covered in Step 3.6. For the moment, it is sufficient to enter
the source information, especially the velocity, as this will be used for the spectral setup.

By default, the Field Setup editor pane (see Fig. 3.2) contains one source tab. The first thing to select
is the Target Type: Individual Pointings or 1 Rectangular field. The target type must be the same for all
sources in a Science Goal, and it is not possible to switch to 1 Rectangular field once additional sources have
been added. You can then use the Add source button to open additional source tabs. You will need to specify
the source information for each source individually. If your source has an entry in SIMBAD or NED,
you can simply type in its name in the Source Name field and hit Resolve to import the field centre coordinate
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and velocity information from there (see Fig. 3.2). Otherwise, this information must be entered by hand. Solar
System targets can be selected from a pull-down list if the Choose a Solar System Object box is checked.

It is your responsibility to ensure that the source information is correct. The source
coordinates and the velocity are used by the OT to calculate the pointing(s) and the sky
frequencies respectively. The expected source properties are used for the technical feasibility
assessment of your proposal, and incorrect or incomplete information may lead to the rejection
of your proposal on technical grounds. For more information on how to convert existing flux
measurements for your source to the peak flux density per synthesised beam required by the OT
please see Knowledgebase articles How can I estimate the Peak Flux Density per synthesised
beam using flux measurements in Jy or K from other observatories? and How do I convert flux
measurements given in Jy km/s or K km/s into the peak flux density required by the OT?.

For each source, you are required to provide an estimate of the expected source properties. The peak flux
density entered should be an estimate of the weakest component driving the sensitivity requirement of your
Science Goal. For continuum observations only the Peak Continuum Flux Density per Beam is required, while
for spectral line and spectral scan observations the Peak Line Flux Density per Beam and the (FWHM) Line
Width must be specified. In the latter case it may also be appropriate to enter the Peak Continuum Flux Density
per Beam if you want to observe both lines and continuum. The Line/Continuum Polarisation Percentage is
required only if full polarization observations are requested. The expected source parameters entered are used
to calculate a number of quantities in the Technical Justification editor (see Step 3.9) and the proposal/science
goal summary sheets. They should be used for guidance when choosing the correlator setup and sensitivity
requirements for your Science Goal.

You can also read in the complete source information from an ASCII file using the Load from
File... button at the bottom of the Field Setup editor. This is particularly useful if you have
a large number of sources. As with adding sources manually you should make sure that the
correct Target Type is set before you load the source list. For the required file format, please
see the Field Setup section of the ALMA OT Reference Manual.

3.5 Configure the spectral setup

The spectral viewer
The spectral viewer is available under the Spectral tab of the Spectral Setup editor. It shows the ALMA bands
offered for Cycle 3 (bands 3, 4, 6, 7, 8, 9, 10), as well as the atmospheric transmission curve of the Chajnantor site.
The OT automatically chooses the water vapour column density appropriate for the observing frequency, and
bases the sensitivity calculation on this Automatic Choice. The Manual Choice is for visualisation purposes
only. Once you specify at least one spectral window, the Local Oscillator (LO1) frequency is calculated, and
(yellow) sidebands appear in the spectral viewer. The sidebands straddle the LO1 frequency and show the
frequency ranges where basebands may be placed. They do not indicate the frequency range that will be
sampled by the observations. ALMA uses 4 basebands (not displayed in the spectral viewer) with a bandwidth
of 2 GHz, within each of which one or more spectral windows may be placed. Spectral windows are defined
directly by the user from within the spectral line table and are represented in the spectral viewer by dark
blue lines. The vertical dark blue line corresponds to the central frequency of a given spectral window, while
the horizontal line represents the frequency range covered. The LO1 frequency, sidebands and basebands are
automatically calculated by the OT based on the spectral windows defined and cannot be controlled by the user
directly. If the OT cannot compute a valid spectral setup for your spectral windows, the sidebands will turn
grey and a red error message will appear. In that case, you will have to modify your spectral setup, if necessary
by placing "offending" spectral windows into separate Science Goals.
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Figure 3.3: The spectral editor pane. Here, continuum observations have been defined.

You can zoom in/out of the spectral viewer by left/right-clicking on the magnifying glass symbol
cursor, or by using the Zoom to Band and Reset buttons. You can move along the frequency
axis by moving the cursor near the axis and dragging the green sliding bars, or using Pan to
Line. For a practical demonstration of the spectral editor please watch OT video tutorial 2:
The Spectral Setup.

In the Spectral Setup editor, start by selecting the Spectral Type and the Polarisation Products Desired, as
these will influence the choices you have for defining your spectral setup. In particular, selecting Full polarisation
will limit you to continuum measurements in Bands 3, 6 and 7, and single pointings of well-centred targets filling
no more than 1/3 of the 12-m Array primary beam. If you are not interested in polarisation information, you
should generally leave the radio button set to the default Dual. XX polarisation is appropriate only if you need
extremely fine spectral resolution (< 30 kHz).

3.5.1 Spectral Line

Selecting Spectral Line will present you with a spectral window table for each of four available basebands. Unless
your Science Goal requires more than 4 spectral windows (see "Multi-region mode" boxed text below), you will
normally define one spectral window per baseband. It is good practice to fill any basebands not needed
for spectral line observations with continuum spectral windows, as this facilitates calibration, especially in the
case of narrow spectral windows.

For ALMA bands 3, 4, 6, 7 and 8 it is not possible to place three basebands in one sideband,
and one in the other for technical reasons. This restriction does not apply to bands 9 and 10.
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Figure 3.4: The spectral line selector tool.

If you cannot find the transition you want in the Spectral Line Selector tool, try the Find
More... button: you will then be able to search online from a more extensive database. By
default, the Spectral Line Selector shows only transitions that are simultaneously observable
with any other transitions already defined in the spectral setup; un-tick the Hide unobservable
lines option to display all transitions corresponding to the search criteria.

You define spectral windows individually for each baseband using either the Select Lines to Observe or the
Add buttons. The first option brings up the Spectral Line Selector tool (see Fig. 3.4), which allows you to
search an extensive database1 for popular transitions based on species, ALMA band, Sky frequency, maximum
upper-state energy or molecules detected in a variety of astronomical sources. Simply select the transition
you want, press Add to Selected Transitions, and a spectral window with a central frequency corresponding to
the transition will be created. The second option Add allows you to manually enter a spectral window central
frequency. Conversion between rest and sky frequencies is automatically performed based on the source velocities
defined in Step 3.4.

Spectral windows must be associated with a correlator mode, which can be selected independently for each
baseband. Double-click on the red text in the Bandwidth, Resolution column to bring up the list of available
options. The bottom entry in bold text corresponds to the lowest spectral resolution (continuum) mode. Please
make sure that the bandwidth and resolution selected for each spectral window are appropriate for the expected
spectral properties of your source(s) as entered in Step 3.4.

1The Splatalogue, for detailed information see http://www.splatalogue.net
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Figure 3.5: Visualisation of spectral line observations in the spectral editor pane.

ALMA bands 9 and 10 are different from the other receivers in that the information coming
from the two sidebands cannot be separated. Therefore, the quality of the data in a spectral
window defined (solid blue lines in the spectral viewer) in one sideband is influenced by whatever
signal is present in the "mirror" spectral window (dashed blue lines, see Fig. 3.3) in the other
sideband. It is therefore advisable to ensure that the "mirror" spectral window does not fall
into a region of bad atmospheric transition, or contain e.g. a strong line. The OT will take
into account the atmospheric transmission in the "mirror" spectral window when calculating a
time estimate.

The data rate estimated for a Science Goal (see Step 3.10) is directly related to the spectral
setup. You should aim to lower the data rate by using spectral averaging wherever possible.
Double-click on the default ’1’ entry in the Spec Avg. column of the spectral window table to
bring up a list of possible spectral averaging factors. Selecting one of the values will immedi-
ately change the spectral resolution in the table. Note that an averaging factor of 2 degrades
the spectral resolution only marginally, but halves the data rate for that spectral window. An-
other way to lower the data rate is to select the lowest resolution (continuum) correlator mode
whenever possible.

Based on the spectral windows defined, the OT will try to configure a spectral setup and display it in the
spectral viewer (see boxed text above). In order for your proposal to pass validation, all spectral windows
for all source velocities must fit within a valid sideband configuration and the same ALMA band.
If several sources with different velocities were specified in Step 3.4, the OT will generate up to 5 separate
frequency tunings based on the velocities, the width of the spectral windows, and spectral line width entered in
the Expected Source Properties. The number of tunings may affect the time estimate for a Science Goal and
can be checked in the Time Estimate dialogue (see Step 3.8).
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Multi-region mode
Multi-region mode allows more than one spectral window to be set up per baseband. In Cycle 3, you can specify
up to 4 spectral windows per baseband, yielding a maximum total of 16 spectral windows in a single spectral
setup containing 4 basebands. Simply Select Lines to Observe or Add extra spectral windows in the baseband
tables. Because only a fixed number of channels are available for each baseband they must be divided between
the spectral windows defined, implying that at a given resolution the bandwidth available for each of two spectral
windows will be half that available for a single spectral window. Therefore, the fraction of the baseband assigned
to each spectral window must be changed in such a way that the sum of all fractions does not exceed 1. The
available choices for the correlator modes in the Bandwidth, Resolution field will then be automatically updated
to reflect the lower number of channels available. Note that within a baseband all spectral windows must have
the same spectral resolution.

3.5.2 Single Continuum

Selecting the Single continuum option is basically a shortcut to defining 4 continuum spectral windows maximising
the available bandwidth (see Fig. 3.3). You are presented with a drop-down list of standard continuum
frequency setups for each of the available ALMA bands, chosen so as to optimise atmospheric transparency.
The sky frequency of the setup can be changed to anything that still yields a valid spectral setup, but any
deviation from the standard frequencies must be fully justified in Step 3.9.

Single Continuum and Spectral Scan observations are specified in the sky reference frame. Unlike
for Spectral Line mode, the velocity information entered in Step 3.4 is ignored, and all sources
are observed with the same frequency tuning.

The spectral windows set up by the OT based on the input continuum frequency for each baseband are
listed in the spectral window tables and visualised in the spectral viewer. Note that the sky frequency specified
corresponds to the LO frequency and is not itself observed for Bands 3, 4, 6, 7 and 8. For Bands 9 and 10, the
sky frequency corresponds to the frequency at the centre of the 8 GHz wide upper sideband.

3.5.3 Spectral scans

The Spectral Scan interface is a convenient way of setting up several correlator tunings to cover a wide, uninter-
rupted frequency range within a single ALMA band. You need to specify the start and end frequency as well as
the desired Bandwidth, Resolution of each spectral window making up the scan. A maximum of 5 tunings can be
observed within one Science Goal, which means there is a trade-off between achieving a high spectral resolution
and covering a wide frequency range (if you want to cover a wider frequency range than possible with 5 tunings
you will have to split the spectral scan across multiple Science Goals). Spectral averaging is possible in the same
way as it is for Spectral Line observations.

The spectral scan interface may in certain cases yield a very inefficient observing strategy,
causing the time estimate to skyrocket. This will happen mostly for observations with relatively
long on-source times and many frequency tunings. It may be more efficient to set up such
spectral scans using separate Science Goals for each frequency tuning.

If the requested spectral scan can be set up successfully, the frequency tunings calculated by the OT are
displayed in the spectral visualiser (see Fig. 3.6) and also listed in the spectral scan table. If not, a red error
message will appear, indicating the origin of the problem. In Cycle 3, spectral scan observations are offered only
for Individual Pointing(s) field setups with one pointing per source and a maximum limit of 150 pointings over
all tunings (i.e. for 5 tunings the maximum number of pointings is 30).
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Figure 3.6: Visualisation of spectral scan observations in the spectral editor pane.

3.5.4 The representative frequency

Every spectral setup is characterised by a representative frequency, which is used to compute the spatial param-
eters of the Science Goal (primary beam, synthesised beamsize, maximum recoverable scale) and controls the
atmospheric transmission used in the time estimate (see Step 3.8). It defaults to the centre of the last spectral
window defined, but can be changed by the user to lie anywhere within the spectral windows of the setup using
the representative window radio button and/or typing in the relevant field below the baseband tables. Note that
the representative frequency is a rest frequency that will be transformed to a sky frequency using the velocity
information for each source. Please check it carefully for each source, and modify it if necessary. For
spectral line observations, the representative frequency should normally correspond to your transition of greatest
interest, or if you are interested in several lines the one that has the poorest atmospheric transmission.

The exact choice of representative frequency can severely impact the time estimate, especially in
the higher frequency bands 7, 8, 9 and 10. If it falls in a region of poor atmospheric transmission
the time estimate will skyrocket compared to a setup with a representative frequency in an area
of good atmospheric transmission. It is important that the representative frequency is set to
the line of interest that falls into the region of the poorest atmospheric transmission, otherwise
the requested sensitivity will not be reached for this line.

3.6 Finalise the spatial setup

Having specified the spectral setup and in particular the representative frequency, you are now ready to finalise
the spatial setup based on the sources you defined in Step 3.4. The maximum total number of 12-m pointings is
150, regardless of whether these are treated as mosaics, offset pointings, or separate sources. 7-m ACA pointings
are counted separately.
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Figure 3.7: Visualisation of individual pointings in the spatial tab of the Field Setup pane.

The spatial editor
The spatial editor (see Fig. 3.7) is found under the Spatial tab of the Field Setup editor. It can be used to view
and edit pointings on a per source basis and will work properly only if you load an image. Either Query one
of the image servers selected from the drop-down menu to display a catalogue image of the area surrounding
your source, or load and display your own FITS image by clicking the folder icon in the spatial editor toolbar
(only J2000 equatorial coordinates are supported). The primary beams of the pointings defined are represented
by red circles, and can be moved, added and deleted interactively. They can be displayed for either the 12-m
or the 7-m antennas if ACA observations have been requested. If Total Power observations are requested, the
area scanned is shown by a turquoise box. For individual pointings, this box dynamically adapts to cover the
pointings defined. You can use the buttons in the toolbar above and below the spatial viewer to perform simple
visualisation operations such as adjusting the cut levels, zooming, and saving the image. Please see OT video
tutorial 3: The Spatial Field Setup for a practical demonstration of all functionalities.

The response of the receivers is not uniform across the antenna primary beam, but falls off
towards the beam edges. The primary beam (represented by the red circles) is defined as the
FWHM of the PSF. For rectangular mosaics, the falloff in sensitivity towards the beam edges
is automatically taken into account by the fact that the individual pointings are set up so as to
overlap. For single pointings, the source should fit within the central 1/3 of the primary beam
for a more or less uniform sensitivity coverage; else a small mosaic should be set up. The inner
third of the primary beam is shown by the smaller green circle in the spatial editor.
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Figure 3.8: Visualisation of a rectangular mosaic.

3.6.1 Individual Pointing(s)

You can visualise and configure the spatial setup for each source individually by selecting the relevant source
tab. By default, there will be just one pointing at the source coordinates specified earlier. Offset pointings can
be added, edited and deleted directly in the ’Field Center Coordinates’ pane, or interactively in the spatial editor
(see boxed text). The Import button will read offset pointings for a given source from an ASCII file in simple
RA, DEC format. You can also Export pointings, e.g. to be used for simulations, in different coordinate formats.

You can choose to process the pointings as a single image by ticking the Custom Mosaic box. In this case, the
pointings must overlap. If the box is not ticked, each pointing will be processed separately. If ACA observations
are requested (Step 3.8) these will have the same pointing centres as the 12-m pointings; any custom-defined
mosaic will not be adjusted for the larger primary beam size of the 7-m antennas. Also, the sensitivity specified
in Step 3.8 is assumed to be per pointing and the estimate entered should take into account any overlap.

3.6.2 1 Rectangular field (mosaic)

By default, the spatial editor shows only the rectangular area defined for the mosaic. To see the
individual pointings set up by the OT, you need to press the Show pointing positions button in
the toolbar above the spatial editor.

The Rectangular Field option is a convenient way to easily set up evenly sampled rectangular mosaics on a
per-source basis. You simply specify the size of the field as p length times q length, the Position Angle and the
Spacing of individual pointings. By default, the spacing is set to Nyquist sampling (Spacing = 0.48113 times
fraction of main beam). If you change this, you must carefully justify your choice in the Technical Justification
(Step 3.9). For rectangular fields, the 7-m Array pointings are automatically set up to optimally sample the area
specified, therefore the number of pointings will be smaller than for the 12-m Array. You may wish to export the
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Figure 3.9: Control and Performance editor pane and the Time Estimate box.

coordinates of the individual pointings; this is easily done using the Export button next to the displayed number
of pointings.

3.7 Select the calibration strategy

You should normally use the default System-defined calibration option in the Calibration Setup editor. The
system-defined calibration is designed to fully calibrate your science observations using the most appropriate
sources available at execution time, and will at least include pointing, bandpass, gain and flux calibration.
Science Goals requiring full polarisation will receive an appropriate calibration strategy. Only experts whose
projects have special calibration requirements should specify User-defined calibration.

3.8 Enter the control and performance parameters

The final technical specifications of your Science Goal are entered in the Control and Performance panel (see
Fig. 3.9). The Configuration Information section at the top of the panel displays information on the array
configurations planned for Cycle 3, and uses the representative frequency defined in the spectral setup to calculate
the Synthesized beamsize and the Maximum recoverable scale of the observations.
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The Desired Angular Resolution (AR) and the Largest Angular Structure (LAS) are used
together to determine the array configuration(s) the observations can be executed in. PIs
cannot explicitly request certain configurations, but should instead make sure that the
AR and LAS entered are correct. The array configuration selected for your observations will
have baselines long enough to achieve an AR better than that requested, and be compact
enough to resolve the LAS. Often this will mean that a number of configurations are acceptable
for a given Science Goal. If it is not possible to achieve both the AR and LAS desired with
just one 12-m array configuration, the OT will automatically add a second 12-m configuration
if possible, and/or suggest use of the ACA. This is not possible for long baselines. For details
on which configurations can be used together, please consult the Technical Handbook.

If you enter 0.0 for the LAS, your Science Goal will be scheduled in any configuration that
meets the AR requirement. For example, if you ask for an AR of 1.2", you will get this or
better (i.e. you may get an AR of 0.5" and your data will be smoothed in the data reduction
process.)

You can define and check technical details of the observations using the following fields (fields displayed in red
must be filled):

Desired Angular Resolution: your choice is guided by the synthesized beamsizes corresponding to the
most compact and most extended configurations available in Cycle 3 as displayed in the Configuration
Information. The value entered cannot be smaller than the synthesized beam size of the most extended
configuration, and cannot be larger than twice the synthesized beam size of the most compact configuration.
You can input the angular resolution in arc-seconds or a fraction of the main beam size.

Observations requesting very small angular resolutions (i.e. those making use of long baselines)
are very inefficient because they need to be heavily calibrated to correct for atmospheric phase
fluctuations. Since the array configuration is determined based on the AR defined in the OT,
it is possible to inadvertently trigger long baseline observations by entering an AR just slightly
smaller than that actually required (e.g. standard B3 continuum observations requiring a 0.34′′
AR will trigger long baselines, while 0.35′′ AR observations will not). You can see if the
observations defined make use of long baselines in the time estimate pop-up (the number of
phase calibrator observations per SB execution will be unusually large, above 25 or so), or by
running a validation check (see Section 3.10). Obviously, long baselines should be avoided if
they are not necessary to achieve a Science Goal.

Largest Angular Structure in source: here you should enter the largest angular structure that you
wish to resolve in your source(s), which may be different from the actual size of the source. The value
entered determines whether you need multiple 12-m configurations and/or the ACA, and therefore has a
direct influence on the time estimate (see the Maximum recoverable scale for the 12-m configurations in the
Configuration Information table for guidance.). The input units are the same as for the angular resolution.

Desired sensitivity per pointing: you should enter the sensitivity required for the most restrictive
line/continuum observation to achieve the scientific aims of the Science Goal, and if relevant mention the
S/N achieved for the remaining lines/continuum in the Technical Justification. In the case of a rectangular
field mosaic you should specify the sensitivity required over the mosaic, not that for individual overlapping
pointings. We recommend that the sensitivity requested is good enough to give a 3 σ detection at the very
least, ideally 5 σ.

Bandwidth used for Sensitivity: for continuum observations, this field is automatically set to Aggre-
gateBandwidth. For spectral line or spectral scan observations you can pick one of six choices given in the
dropdown menu:
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- RepresentativeWindowBandWidth: the bandwidth of the spectral window chosen as the representative
spectral window (and containing the Representative Frequency) in Step 3.5

- RepresentativeWindowResolution (default): the (Hanning-smoothed) spectral resolution of the repre-
sentative spectral window, taking into account spectral averaging

- AggregrateBandwidth: the summed bandwidth of all your selected spectral windows
- LargestWindowBandwidth: the bandwidth of your widest spectral window defined
- FinestResolution: the finest (Hanning-smoothed) resolution of any spectral window, taking into ac-
count spectral averaging

- User: a bandwidth of your choice (useful if you are intending to smooth your data after observation
to achieve a certain S/N)

Please pay close attention that the Bandwidth used for sensitivity is appropriate for your scien-
tific aims. For spectral line observations we recommend that it is at most 1/3 of the expected
spectral line width. Selecting too wide a bandwidth will lower the time estimate, but yield too
low a sensitivity.

Do you request complementary ACA observations: press the Suggest button to see whether the
OT recommends/allows ACA observations based on the requested AR and LAS. The ACA comprises the
7-m Array as well as the Total Power (TP) Array. Note that the TP array is not offered for continuum
observations and in Bands 9 and 10. You can choose to override the recommendation of the OT, but
must carefully justify this in the technical justification. Note that the ACA cannot be used with the most
extended 12-m configurations as this would result in a gap in the baseline coverage.

In Cycle 3, the OT will differentiate between the need for the 7-m array and the Total Power
(TP) array based on the LAS entered, i.e. the TP array will be invoked only if the LAS cannot
be recovered by the 7-m array. This is in contrast to previous cycles, where the TP array was
automatically included with the 7-m array whenever possible.

Science goal integration time estimate: The Time Estimate button will estimate the total time
required to achieve the desired sensitivity goal on the 12-m antennas, including calibrations, multiple
pointings, and overheads (see Fig. 3.9). In the event that two 12-m configurations are needed to provide
sufficient baseline coverage, the time breakdown will be calculated for the more extended of the two, while
the time required for the more compact configuration will be calculated from the former using a fixed
multiplicative factor. Similarly, the 7-m Array and TP Array observations are estimated to require a factor
of 2 and 4 times the most extended 12-m Array observations respectively. Unless specified otherwise (see
below), it is the total time reported here that will be used by the observatory as an estimate of how long
your project will take to complete. Note that, for Cycle 3, proposals requiring more than 100 hours cannot
be submitted.

Override OT’s sensitivity-based time estimate If your Science Goal is not sensitivity driven, but
instead requires a certain time (e.g. for a monitoring experiment) you can choose to override the OT’s time
estimate. The time entered should be the total time (including calibrations and overheads) for the more
extended 12-m configuration needed; time estimates for the ACA are the automatically calculated by the
OT.

Are the observations time-constrained? The OT now has the ability to capture the following time
constraints:

- Single Visit: specify fixed time intervals during which your observations should be executed. The
observations will be carried out only once in total, within any of the time windows specified. You
can manually Add time windows individually, or Import a list of time slots from an ASCII file. See
the Control & Performance section of the ALMA OT Reference Manual for the format required.
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Figure 3.10: The time constraints interface and Time Estimate box for the example of Multiple Visits.

- Multiple Visits: define multiple visits for your Science Goal. The timing constraints of the individual
visits are specified in terms of arbitrary, fixed or relative time intervals (see Fig. 3.10). Here, the
observations will be carried out once for each visit specified. The time estimate computed by the
OT will be multiplied by the number of visits.

Selecting Tool in the OT menu gives you access to a number of useful tools to help you better
plan your observations. You can use the Sensitivity Calculator to bring up a pop-up window
that allows you to experiment with project execution times and sensitivities, the Project time
summary to give a time and data rate summary, and generate printable and pdf summaries
of individual Science Goals as well as the project.

3.9 Enter the Technical Justification

The technical justification editor has been completely re-designed for Cycle 3 with the aim of making it easier
for PIs to fill a complete Technical Justification. Note that any supporting figures (e.g. simulations) should be
included in the supporting material attached in Step 3.2).

The technical justification is now entered in three sections: Sensitivity, Imaging, and Correlator configuration.
Relevant parameters as taken or computed from the Science Goal setup and the Expected Source Properties are
displayed for each. If the OT detects values it thinks should be double-checked, an informative message is
displayed in blue. You should pay special attention to these issues in your justification text.

You must enter a short justification text in the free-format text boxes of each section. In addition, text
boxes will appear for any choices that need to be justified. These include using single polarisation, non-standard
continuum frequencies, non-Nyquist spatial sampling, a user-defined calibration strategy, overriding of the OT’s
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Figure 3.11: The technical justification editor.

suggestion of the ACA or time estimate, low maximum elevation of a source, time-constrained observations
and high data rates. For detailed guidelines on filling the Technical Justification please see Appendix C of the
Proposers Guide and OT video tutorial 4: The Technical Justification.

3.10 Validate and submit your project

By clicking on Menu > Validate or the corresponding tick icon in the toolbar you can check whether the project
contains any setup errors (see Fig. 3.12). Successful validation is required before submitting a project. Warnings
are for your attention and should be double-checked, but they do not prevent you from submitting a technically
sound proposal. Double-clicking on an error/warning message will take you to the relevant Science Goal, so that
you can easily identify and correct the problem. If all is well, the Feedback pane will report “No problems found”
(Fig. 3.13). Your project is now ready to be submitted!

Before submitting your project, you should check whether any of your Science Goals make use of
non-standard modes. Non-standard modes require manual intervention during data reduction
and will be allocated up to a maximum of 25% of the available observing time. You can see
which, if any, of your Science Goals use non-standard modes on the Proposal summary sheet.
Non-standard modes will also trigger a validation warning, and include long baselines, full
polarisation observations and bands 8, 9, and 10, among other things (see Appendix A of the
Proposers Guide for a complete list). Since it is expected that observing time for these modes
will be more competitive than for standard observations you should ensure that you did not
inadvertently trigger a non-standard mode.
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Figure 3.12: An example of failed validation.

Figure 3.13: Successful validation!

To submit your project to the ALMA archive, select File > Submit Project in the menu bar. You and all
of your Co-Is should receive a confirmation e-mail after each proposal submission. Once you have submitted,
the Unsubmitted Proposal label in the blue proposal status bar will be replaced by a red Submitted label. This
indicates that the proposal has been stored in the ALMA archive and assigned the Project Code listed in the
top-level overview panel of your proposal. You are encouraged to save your project to disk after submission in
order to ensure that any updates are made on the submitted version.

You can make changes and re-submit your Submitted proposal until the deadline; any re-submission will
overwrite the previous version of the proposal stored in the archive. If you want to edit the proposal and then
submit it as a new project you need to work with an unsubmitted version of the proposal that has not yet been
assigned a project code.

For more detailed information on the ALMA OT and the technical capabilities in Cycle 3 you are invited to
consult the documentation available on the Science Portal. If you have any questions or comments please feel
free to submit a ticket to the ALMA Helpdesk, also accessible from the Science Portal.
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